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Chapter One - Installation and Setup   

This chapter will guide you through installing and setting up Control System Supervisor (CSS) to operate 
properly on your computer.  

1.1 System Requirements  

The first thing you should do is verify that your computer is capable of running CSS. Almost any computer that 
will run Windows may be used with Control System Supervisor.  

NOTE: CSS is not currently compatible with Windows NT.  

Minimum System Requirements:  

386 or faster IBM compatible computer 

4 megabytes of RAM 

VGA video card and VGA color monitor 

40 megabyte or larger hard disk 

Mouse or other windows compatible pointing device 

1.44 megabyte 3 1/2"  disk drive 

Microsoft Windows 3.1 or  Windows95 

One or more communications ports (Comports)  

Recommended Minimum System:  

486DX or Pentium computer with VESA or PCI local bus 

8 megabytes of RAM 

SuperVGA local bus video card and SuperVGA color monitor (for 256 Color or High Color mode) 

100 megabyte or larger hard disk 

Mouse or other windows compatible pointing device 

1.44 megabyte 3 1/2"  disk drive 

Microsoft Windows 3.1 or  Windows95  

A SuperVGA card configured for ‘High Color’ or ‘True Color’ mode is highly recommended.   

1.2 Setting up Microsoft Windows to Run CSS  

The only setting in Windows required for CSS is that at least one communications port must be set up in the 
Windows Control Panel. All of the communications ports that you wish to use in CSS must also be set up in 
Control Panel. The exact setting used are not important, but Windows must know the ports exist.  

CSS is compatible with any standard VGA resolution and color depth supported by Windows. However, a 
resolution of at least 800 by 600 and a color depth of greater than 256 (‘High Color’ or ‘True Color’ mode) are 
highly recommended.  

1.3 Installing CSS on Your Hard Drive  

To install CSS, insert diskette #1 in drive A: and proceed according to the following:  

Windows 3.1 users: 
Select ‘Run’ from the ‘File’ menu. 
Type ‘A:Setup’ in then ‘Command Line’ field. 
Click the ‘OK’ button.     
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Windows 95 users: 
Select ‘Run’ from the ‘Start’ menu on the Windows task bar. 
Type ‘A:Setup’ in the ‘Open’ field. 
Click the ‘OK’ button.  

The installation program will prompt you for a drive and directory to install TO. It is recommended that you install 
to the C:\CSS (or D:\CSS) directory if this is the first time you have installed CSS on this computer.  

CSS will be copied to your hard drive automatically. When asked if you wish to create a program group (Win31) 
or add CSS to the ‘Start’ menu (Win95), choose ‘Yes’   

You will then be asked if you wish to move the program authorization on to your hard drive. This is required for 
CSS to operate properly without disk #1 in the drive. Selecting ‘Yes’ will move the authorization to your hard 
drive and enable CSS to operate.  See ‘Program Authorization’ for more information.  

1.4 Removing CSS from Your Hard Drive  

Windows 3.1 users: 
Double click the left mouse button on the ‘Un-install Control System Supervisor’ icon in the ‘Control 
System Supervisor’ program group.   

Windows 95 users: 
Double click the ‘Add/Remove Programs’ icon in ‘Control Panel’. Select ‘Control System Supervisor’ 
and click the ‘Add/Remove’ button.  

Selecting ‘Automatic’  un-installation will not delete any files that you have created in CSS. Because of this, the 
actual \CSS directory may not be deleted. Use File Manager or Explorer to delete the \CSS directory.   

Selecting ‘Custom’ un-installation will let you manually select which files to delete.  

1.5 Program Authorization  

CSS requires that an ‘authorization’ file be present on at least one disk drive of the computer CSS is running on. 
Normally, when you install CSS the authorization will be copied to your hard drive. If CSS does not find the 
authorization file on the hard drive, it will check the diskette drives starting with drive A:. If it is not found on any 
of your disk drives, CSS will not run.  

Your original diskette comes with 1 ‘install’ of the authorization. In other words, you can install the authorization 
on one computer only. You can install CSS on multiple computers but only install the authorization on one of 
them. You can then carry the original diskette to any computer that CSS is installed on and insert it in the 
diskette drive to enable CSS to operate. You DO NOT need the original diskette to run CSS on the computer 
the authorization was installed on. If desired, more ‘installs’ may be purchased so you don’t need to carry the 
original diskette around with you. Contact your Andover dealer for pricing and availability.  

If you wish to move the authorization form diskette to hard drive or from hard drive to diskette, insert the original 
diskette in drive A: and run: 
‘A:Winmove A: C:’  to move from diskette to hard drive, or 
‘A:Winmove C: A:’  to move from hard drive to diskette.  

You can determine how many ‘installs’ remain on you original diskette by running: 
‘A:Winmove A: C: /C’.  

If you are running any type of disk defragmenting program such as ‘Norton Utilities’, make sure it is set to not 
move ‘hidden’ files, otherwise the authorization may be lost.   

If the authorization is somehow lost, CSS can be re-authorized by typing in a special authorization code. 
Contact your Andover dealer for more details.  
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Chapter Two - Tutorial: Getting Started   

2.1 Running CSS  

Windows 3.1 users: 
Double click the left mouse button on the ‘Control System Supervisor’ icon in the ‘Control System 
Supervisor’ program group. 
If you would like CSS to run every time Windows 3.1 is loaded, make a copy of the ‘Control System 
Supervisor’ icon and place it in the ‘Startup’ program group. Refer to your Windows documentation for 
details on how to do this.  

Windows 95 users: 
Select ‘Programs’ from the ‘Start’ menu, then select ‘Control system Supervisor’. 
If you would like CSS to run every time Windows 95 is loaded, open the ‘Startup’ folder and create a 
shortcut to CSS. Refer to your Windows documentation for details on how to do this.  

2.2 Logging In to CSS  

At the log in screen (figure 2.1) type your ‘username’, press [Tab], then type your password and press [Enter]. 
The default username is ‘CSS’ and the default password is also ‘CSS’. You should change this as soon as 
possible to avoid unauthorized access to CSS (see ‘System Setup’).  

 

Figure Chapter Two .1 Login Screen 

Tip! You can have CSS automatically log in for you every time CSS is executed. See ‘System Setup’ for 
more information.   
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2.3 Main Menu Screen 

Once you have logged in to CSS you will see the ‘Main Menu’ screen (figure 2.2).  The main menu is displayed 
when you are logged in to CSS. The dark area between the Main Menu and the ‘Status Bar’ is where all graphic 
displays, schedules, history charts, etc. will appear when in use, but for now it is empty.  

Shows Controller Name
when Connected

Shows Connect
Status

Shows Number of
‘Active’ Alarms

Shows
Current
Local Time

Speed Buttons for Frequently Used Menu Selections

 

Figure Chapter Two .2 Main Menu Screen 

Tip! You can have CSS automatically connect with a controller and open a graphic display every time CSS 
is executed. See ‘System Setup’ for more information.   

2.4 Configuring the Communications Ports in CSS  

You need to let CSS know which communications ports (Comports) to use before you can connect with a 
controller. From the main menu select ‘File|Setup|System’ (the | is used to separate menu selections, in other 
words, select ‘File’ then select ‘Setup’ then ‘System’).  

Click on this ‘Tab’ to show the
communications page. 

Figure Chapter Two .3 Communications Setup   
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For now you can ignore most of these options. Make sure the ‘Default Main Port’ and ‘Default Alarm Port’ are 
set properly. The main port is the port you will use most often to connect to a controller. The alarm port is a 
secondary port that will be monitored for alarm messages called in from other controllers. Alarms will be 
received on both the Main and Alarm ports.  The main port and alarm port may both be set to the same physical 
comport if you do not want to monitor alarms from controllers other than the one to which you are currently 
connected.  

‘Phone Service’ must also be set properly if you will be using a modem to connect to controllers.  

2.5 Using Folders   

‘Folder’ is a term used to refer to the window that contains a list of items such as controllers, displays or 
schedules. Folders are used often in Control System Supervisor. A working knowledge of how to use folders is 
very important.   

 

Figure Chapter Two .4 Sample Folder  

The upper portion of the folder contains an icon and/or a description of each of the items in the folder. The 
bottom portion contains a row of tabs. Each of these tabs will display a different group of items when clicked. 
You may have as many tabs as you wish. Use these tabs to group the items in some logical order. You could 
group controllers by state, group graphic displays by the floor of the building they represent, etc. Planning ahead 
on how you want to group items is a good idea that will save you time and make the system easier to use.   

Selecting Items 
To select an item, simply click on it once to highlight it. You may then click one of the buttons on the right side. 
Double clicking an item is the same as selecting it and pressing the default button on the right. If there are more 
items than will fit in the folder window, a scroll bar will appear to the right of the items. Click anywhere on this 
scroll bar to scroll through the items. You may also make the folder larger by clicking and dragging the lower 
right corner of the folder. This will allow you to see more items at one time.  

Editing Items 
To add or edit an item, select it and press the right mouse button. A menu will appear with the following options:  

Edit - Display the edit dialog box specific to this item. 
Change Icon - Change the icon that represents this item. 
Create New - Create a new item. 
Cut - Delete the selected item and place it in the clipboard. 
Copy - Copy the selected item to the clipboard. 
Paste/Insert - Paste the item currently in the clipboard. 
List View - Hide the icons and show a simple list of items. 

Copying Items 
It may be easier at times to make copies of existing items and change the copies rather than create whole new 
items. To do this, select the item you wish to copy, click the right mouse button and select ‘Copy’ from the pop 
up menu. The selected item is now in the ‘clipboard’. You may now change to a different tab and click the right 
mouse button again. Select ‘Paste/Insert’ from the pop up menu and you have a copy of the original item that 
you may change as desired.  

Sorting Items 
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You can change the position of an item in a folder by holding down the <Alt> key and left clicking in the folder. 
The item will be moved from its original position to the mouse cursor location. To sort items with the keyboard, 
hold down the <Alt> key while moving the item with the arrow keys.   

Selecting Tabs 
To select a different group of items, click on the tab that describes the group you wish to work with. If there are 
more tabs than will fit in the folder window, two small arrows will appear just to the right of the tabs. Click these 
arrows to scroll through the tabs. You may also make the folder larger by clicking and dragging the lower right 
corner of the folder. This will allow you to see more tabs at one time.  

Editing Tabs 
To add or edit a tab, select it and press the right mouse button. A menu will appear with the following options:   

Rename - Change the name of the selected tab. 
Create New - Create a new tab. 
Delete - Delete the selected tab.   

Tip! The name given to a tab may contain an '&' to make the next letter underlined. For example, 
‘&Western US’ will appear on the tab as Western US. You may then press 'W' to switch to that tab rather 
than clicking it.   

2.6 Creating a New Controller  

Before you can connect with a controller you must ‘create’ it in CSS. Click on the telephone button at the top of 
the screen, or select ‘Controller|Connect’ from the main menu. The controllers ‘folder’ will be displayed. Click 
the right mouse button anywhere in the blank area in the middle of the folder and select ‘Create New’ from the 
menu that will appear.  

Right-click anywhere in this
area and select ‘Create New’ 

Figure Chapter Two .5 Controllers Folder 

After selecting ‘Create New’ you will be prompted for the type of controller you want to create. Select the 
controller type and click ‘OK’. For this tutorial, we will be creating an Andover Infinity controller, but you may 
choose any type and click the ‘Help’ button for information specific to that controller type.  

2.7 Configuring a Controller  

This is the Controller Edit Dialog (figure 2.6). Here is where you will enter the information necessary for CSS to 
log on to and operate with this controller. It is important that all fields have the correct information entered into 
them.  

‘Username’ and ‘Password’ should be the same as you normally use to log on to this controller. It 
should have a high enough access to allow for backup and reload of the controller's memory. 
‘Controllers Name’ should be the actual name given to the controller when it was installed. 
‘Disk Directory’ and ‘Alarm ID’ can be any 1-8 characters you wish. 
IMPORTANT! ‘Max Response Delay’ must have a correct value. Click ‘Help’ button for more details.  
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Description can be any text you
wish, up to 32 characters

(Infinity Only) This item is very important!
Click the Help button for more information.

Click ‘Help’ button for
detailed information.

 

Figure Chapter Two .6 Controller Edit Dialog   

Next, you need to supply CSS with the information necessary to connect with this controller (figure 2.7).  

Set ‘Connect Type’ to ‘Direct’ if controller is directly connected to the computer with a cable. 
For ‘Modem Init. String’, click the ‘down arrow’ to the left of the edit box and select the first string in 
the list. 
‘Pre-Logon’ and ‘Post-Logon’ should be empty unless the controller is wired through a ‘smart’ serial 
switching device. 
For direct connections, ‘Connect String’ and ‘Disconnect String’ should be empty unless the controller 
is wired through a ‘smart’ serial switching device. 
Leave ‘Suppress Logoff’ unchecked.  

Click the ‘OK’ button when finished entering this controller's information.  

Click on this ‘Tab’ to show the
communications page. 

Figure Chapter Two .7 Controller Communications Dialog   
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2.8 Connecting with a Controller  

To connect with a controller, simply click the left mouse button on the desired controller's icon, then click the 
‘Connect’ button. CSS will the attempt to connect with this controller. If all the information provided for this 
controller is correct, you should now be connected. The status bar at the bottom of the screen will display the 
controller's description and show ‘Online’.  

If you need to change this controller’s
configuration, click the right mouse button
on this icon and select ‘Edit’.

 

Figure Chapter Two .8 Controllers Folder 

Tip! You can also ‘double click’ the left mouse button on the controller's icon instead of clicking the 
‘Connect’ button.  
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Chapter Three - Tutorial: Graphic Displays   

3.1 Creating a Graphic Display  

A graphic display is basically a real-time report. It can display temperatures and setpoints on the screen as text, 
or using a variety of meters and gauges. Equipment can also be controlled with several types of switches and 
potentiometers.  

Once connected with a controller, select ‘Display’ from the ‘View’ menu and the ‘Displays’ folder will appear. 
Click the right mouse button anywhere in the blank area in the middle of the folder and select ‘Create New’ from 
the menu that will be displayed.  

Right-click anywhere in this
area and select ‘Create New’ 

Figure Chapter Three .1 Displays Folder  

You will be asked to enter a description and a filename. The description is any text you want to appear under 
the icon in the ‘Displays’ folder. The filename can be any 1-8 character string you choose. Click the ‘Help’ button 
for more information.  

For this example, we will give the display a description of ‘First Floor’ and the filename ‘FLOOR1’ (you may use 
a different description and filename if you wish). 
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3.2 Editing a Graphic Display  

With the ‘Displays’ folder open, click on the display you wish to edit and then click the ‘View’ button. A screen 
similar to figure 3.2 will appear. This is our new display (it is empty until we add something to it).  

Dark area is the ‘editable’
portion of a display. This is
where you can place a
picture, meter, switch, etc.

Lighter area is the border that will fill
up the area of the screen not covered
by the ‘editable’ portion.

The description of this display. 

Figure Chapter Three .2 Empty Graphic Display 

You probably want to edit the display and add something to it so it will be more useful. Select ‘Edit Mode’ from 
the ‘Options’ menu. The display is now in ‘Edit Mode’ and the description at the top will change to ‘Editing: First 
Floor’. Notice also that the ‘Options’ menu has changed to include some new selections.  

If you would like to add a bitmap (picture) to this display, copy it into the \CSS\BITMAP directory. All pictures 
used in CSS must be in standard Windows .BMP format and have a .BMP extension. The paint program that 
comes with Windows will create .BMP files, as well as convert .PCX files to .BMP.  

Once the .BMP file has been placed in the \CSS\BITMAP directory,  select ‘Configure...’ from the ‘Options’ 
menu. Click on the ‘BMPFile’ entry and then click the ‘+’ button. Select the picture you want to place on this 
display. The picture will always be centered in the ‘editable’ area of the display.  

Now let’s add a ‘component’ to the display. Any meter, gauge, switch, etc. that you can add to a display is 
referred to as a ‘component’. CSS comes with many pre-defined components. In this example we will place the 
average temperature reading for the first floor on the display. To see the components and choose one to use for 
the first floor’s average temperature, select ‘View Components’ from the ‘Options’ menu.  
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The components will be displayed in the ‘Components’ folder.   

Click on this ‘Tab’ to see the
‘String Display’ component.

 

Figure Chapter Three .3 Components Folder  

For this example, choose the ‘String Display’ component because it is the easiest to use. Click the left mouse 
button on it (it should now be highlighted) and then click on the displays ‘editable’ area at the approximate 
location that you want to place this temperature reading.  

This component is now a part of the display. You should see a blue square with eight red ‘handles’ around it 
and ‘Value=‘ written inside. The handles indicate that this is the ‘selected’ component.   

As you move the mouse cursor over the components handles you will see the mouse cursor changing its shape. 
If you place the cursor over one of these handles and hold the left mouse button down you will be able to re-size 
the component as you move the mouse around the display. You can also press and hold the left mouse button 
anywhere else on the component and move the component itself around the display.  

Tip! You can hold down the <Ctrl> key and click to select multiple components. They can then be moved 
around, cut, deleted, etc. at the same time.  

The component is actually working now, but we have not yet told it what controller variable (input, output, etc.) 
to show. Go ahead and close the components folder now to get it out of your way by selecting ‘View 
Components’ again from the ‘Options’ menu.  

Make sure the component is selected (has the eight red handles around it) then click and hold the right mouse 
button down on top of the component. This will show a menu of options (consult the help file for a description of 
these options). Select ‘Control Point’.  

Tip! Most of these menu selections also have keystrokes to activate them. This can make editing many 
components much easier. The keystrokes are listed on the right side of the menu itself. 
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3.3 Creating Control Points  

A control point is any variable, input, output, flag, etc. in the controller that you want CSS to use on a display. 
Any control point you want to show on a display MUST be created in the ‘Control Points’ folder.  

Right-click anywhere in this area and
select ‘Create New’ 

Figure Chapter Three .4 Control Points Folder 

When creating a new control point, it is important to select the correct point ‘type’. The following is a list of types 
and a few examples.  

Digital - Digital output (fan or chiller), or a digital input (air flow sensor or remote override switch). 
Analog - Analog output (rooftop control unit or vane), or an analog input (temperature or humidity 
sensor). 
Tri-State - Any tri-state output with valid states of ON, OFF and -ON. 
Variable - A ‘V’ variable (AC256) or numeric variable (Infinity). 
Flag - An ON/OFF variable. 
Time - A CSS specific time variable for use with custom schedules. Not the same as a controller 
TimeDate variable. 
Date - A CSS specific date variable for use with custom schedules. Not the same as a controller 
TimeDate variable. 
String - An Infinity string variable.  

For our example of the first floor average temperature, select ‘Analog’ as the point type.  
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3.4 Editing Control Points  

Here you will give CSS the information necessary to access the control point. The information includes: 
Point Name - The actual name of the point in the controller. For Infinity, the point name may also 
contain a controller name (for example, Infinity2 OutsideAir). 
Point Type - See Creating Control Points (above) for more information. 
Units - Set this to the engineering units of the point (Degrees, Volts, etc..) This is optional. 
Toggles - These two options control whether this point may be modified and disabled from a display. 
The user currently logged in to CSS would also have to have a password level that allows point 
modifying.   

 

Figure Chapter Three .5 Control Point Edit Dialog 

In our example the point is named ‘Fl1.Avg’ but you should supply the name of a valid temperature input on this 
controller. Check the ‘Can Disable’ and ‘Can Modify’ boxes if you want to be able to modify this input from a 
display.  

Click the ‘OK’ button to save this control point to disk.  You can now click this point’s icon and then click the 
‘Select’ button of the Control Points folder. The display should begin to show the current temperature on the 
screen, although you probably want to make the component show something more useful than ‘Value=73.2’.  

3.5 Editing Components  

To edit the appearance and behavior of a component, select it by clicking the left mouse button anywhere on 
the component. It will then have eight red sizing ‘handles’ around it. Click and hold the right mouse button over 
the component and a menu will appear. Select ‘Edit...’ or press <Ctrl>-E and you will see a dialog box similar to 
figure 3.6.   

Use the scroll
bar to see more
options.

Set the caption to
‘Fl1.Avg=@ Degrees’
or any other text you
wish. The @ is where
the value will appear.

Click the ‘Help’
button for a
description of all
options.

 

Figure Chapter Three .6 Component Editor  

Change the caption to read ‘First Floor Temperature is @ Degrees’ or any text you wish this component to 
show. Place an ‘@’ where you want the actual value read from the controller to be inserted into the text. Feel 
free to change the color, alignment or any other options you wish to try. You can always click the ‘Cancel’ button 
to abort all of the changes you have made. Click ‘OK’ to save the changes to this component. 
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After changing the caption of this component, it may not be large enough to display all the text. You can grab 
one of the component sizing handles and move the mouse around until it has the appearance you want.  

Once you are satisfied with a component’s appearance, you may want to click the right mouse button on it and 
select ‘Save as Component’. This will add it to the components folder, saving the size, color and behavior. You 
can then easily place it on other displays by selecting it from the components folder just like one of the pre-
defined components. You should probably not save every component you design because eventually you will 
have so many that it would be difficult to find the one you want.    

3.6 Viewing a Graphic Display  

To view a display, select ‘Display’ from the ‘View’ menu and a ‘Displays’ folder similar to figure 3.7 will appear. 
Highlight the display you wish to view and click the ‘View’ button. You may also double click the left mouse 
button on the icon of the display you wish to view.  

There may be other pages that have more
displays on them. Click the ‘Tabs’ to see
them.

Double click this icon
to view the ‘First Floor
Temperatures’ display. 

Figure Chapter Three .7 Displays Folder 

Some displays may contain components that can be manipulated with the mouse. These components might 
include switches, potentiometers or text strings.   

Switches may be changed by clicking on them, while potentiometers can be changed by clicking and dragging 
the left mouse button on them. If, while dragging the mouse, you decide that you do not want to change the 
value, you can move the mouse off of the component and it will revert back the value it had previously.  

If modifications are allowed to this component you may click the right mouse button on it to allow you to 
enable/disable the control point, modify the points value, or get information on the point. Your system 
administrator has control over what may be modified.  

Note! Modifying a control point does NOT automatically disable it.  

3.7 Closing a Graphic Display  

When you are finished viewing a display it can be closed by selecting ‘Close’ from the ‘Window' menu. A display 
may also be closed  by double clicking the left mouse button on the Windows ‘Control Menu’ at the top left of 
the display.  

Displays should always be closed when you are finished viewing them because having unnecessary displays 
open will slow the update of all other displays.  



 

4-1

Chapter Four - Tutorial: Schedules   

4.1 Creating a Schedule  

A schedule is a convenient way to control equipment ON/OFF times. CSS displays a grid of times and dates 
that you can modify and CSS will automatically update the programming in the controller. The schedules 
operate in the controller by way of a pre-defined program that is loaded into the controllers memory. This 
program will set a controller variable to a specific value based on the time of day (1,2,3 or 4 depending on which 
ON/OFF pair the current time falls within, or 0 if it does not fall within any ON/OFF pair). The controller 
programming can then reference this variable to control equipment.  

Once connected with a controller, select ‘Schedule’ from the ‘View’ menu and the ‘Schedules’ folder will be 
appear. Click the right mouse button anywhere in the blank area in the middle of the folder and select ‘Create 
New’ from the menu that appears.   

Right-click anywhere in this
area and select ‘Create New’ 

Figure Chapter Four .1 Empty Schedules Folder  

Select the type of schedule you would like to use and click the ‘OK’ button.  

NOTE! This chapter does not cover ‘Custom Schedules’. They are actually graphic displays that are stored 
in the Schedules folder. See the chapter on Graphic Displays for more information.  

Next, you will have to supply some details on how you want the schedule to be stored in the controller. The 
information needed varies widely between different controller types. Click the ‘Help’ button on the ‘Edit 
Schedule’ form for details specific to the type of controller you are working with.  
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4.2 Modifying Schedules  

To view or modify a schedule, select ‘Schedule’ from the ‘View’ menu and a ‘Schedules’ folder similar to figure 
4.2 will appear. Highlight the schedule you wish to view and click the ‘View’ button. You may also double click 
the left mouse button on the icon of the schedule you wish to view.   

There may be other pages that have more
schedules on them. Click the ‘Tabs’ to
see them.

Double click this icon
to view the ‘First Floor
Lighting’ schedule. 

Figure Chapter Four .2 Schedules Folder  

Clicking the view button will display a schedule form similar to figure 4.3. Click the left mouse button on the time 
or date you want to modify and then simply type the new value. You may also use the arrow keys to move 
around the grid. After you have made all the changes that you want to make, click to ‘OK’ button to save the 
changes and optionally load the changes into the controller. Click the ‘Cancel’ button to abort all the changes 
you have made.   

Click this tab to view the
special holiday schedules.

No OFF time will keep
schedule ON past midnight.
Next day should have ON
time of 12:00am.

Copy Monday’s
times to Tuesday
through Friday. 

Figure Chapter Four .3 Schedule Edit Screen  

Below are some important facts to keep in mind when modifying schedules.  

Times may be entered as am/pm or military times (2200 or 10:00pm), but will always be displayed as 
am/pm times. 
Press the ‘backspace’ key then [Enter] to clear a time or date. 
For times, schedule will be ON as soon as the minute changes to the ON time and OFF when the 
time changes to the OFF time. 
Holidays become active at midnight on the ‘Begin’ date and remain active through 11:59pm on the 
‘End’ date. 
To keep schedule ON continuously past midnight (e.g. 10:00pm until 2:00am), enter 10:00pm for the 
ON time and no OFF time. Set the next day to 12:00am ON time and 2:00am OFF time. 
ON/OFF pairs do not have to be entered in chronological order. You can use three pairs for normal 
scheduling and the forth pair to enter special times. 
The schedule MUST be loaded into the controller for the changes to take effect. 
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Chapter Five - Tutorial: History Charts  

5.1 Creating a History Chart  

A history chart displays past values of control points in an easy to understand graphical format. This allows you 
to quickly determine how well your system is operating, fine tune the controllers programming and display 
energy usage and savings.  

Once connected with a controller, select ‘Schedule’ from the ‘View’ menu and the ‘Schedules’ folder will be 
appear. Click the right mouse button anywhere in the blank area in the middle of the folder and select ‘Create 
New’ from the menu that appears.  

Right-click anywhere in this
area and select ‘Create New’ 

Figure Chapter Five .1 Empty Histories Folder  

Next, you will have to supply some details on what type of data you want to display on the chart and how you 
want it to appear. The information needed varies widely between different controller types. Click the ‘Help’ 
button on the ‘Edit History’ form for details specific to the type of controller you are working with.   

5.2 View a History Chart  

To view a history chart, select ‘History’ from the ‘View’ menu and a ‘Histories’ folder similar to figure 5.2 will 
appear. Highlight the history you wish to view and click the ‘View’ button. You may also double click the left 
mouse button on the icon of the chart you wish to view.  

There may be other pages that have more
histories on them. Click the ‘Tabs’ to see
them.

Double click this icon to
view a history of the ‘First
Floor Temperatures’. 

Figure Chapter Five .2 Histories Folder   
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Almost all aspects of a charts appearance can be changed. The row of buttons along the top of the chart allow 
changing the type of chart (2D, 3D, line, bar, etc.). Once you are satisfied with the charts appearance, click the 
‘OK’ button to save the chart. Close the window through the Windows ‘Control Menu’ in the upper left (or press 
<alt>-F4) to cancel the changes. Please note that canceling changes will not affect the data itself, only the 
appearance of the chart.    

Date and time of rightmost reading.
Click to scroll through data. Go
to first reading, back one ‘page’
or back one reading.

Right click these
markers to get
details on each
reading. 

Figure Chapter Five .3 History Chart - 2D Lines  

The history data may also be viewed in a tabular format. This is useful for easily determining the exact values of 
the data. Clicking the ‘OK’ button when the data is displayed in tabular format will cause the chart to default to 
tabular format every time the chart is viewed.  

Click
hammer and
select ‘Data
Editor’ to
view data in
tabular form. 

Figure Chapter Five .4 History Data - Tabular Format 

Note that the bottom-most reading in tabular format corresponds to the right-most (or most recent) reading on 
graphical charts.           
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A variety of chart types can be used to display virtually any type of data. Click the ‘Help’ button for more details. 
Any user can change the appearance of the chart, but the changes will only be saved if their password level 
allows display/schedule/history editing.  

Click these buttons to
change the appearance
of the chart. Line or bar,
2D or 3D, angles and
scale.

Type a date and time to view the
reading nearest that time. 

Figure Chapter Five .5 History Chart - 3D Bars  
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Chapter Six - Tutorial: Custom Reports   

6.1 Creating a Custom Report  

Reports are very similar to graphic displays with a few exceptions:  

A report cannot be sized. The entire report will be scaled to fit a single page on your particular printer. 
The control point values are read only once, when the report is first opened. 
Reports can be automatically printed. 
Not all of the graphic display components are available with reports. 
The 'String' component can have a field name, and a calculation that can modify the value displayed.  

Once connected with a controller, select ‘Report’ from the ‘View’ menu and the ‘Reports’ folder will appear. Click 
the right mouse button anywhere in the blank area in the middle of the folder and select ‘Create New’ from the 
menu that will be displayed.  

Right-click anywhere in this
area and select ‘Create New’

 

Figure Chapter Six .1 Reports Folder  

You will be asked to enter a description and a filename. The description is any text you want to appear under 
the icon in the ‘Reports’ folder. The filename can be any 1-8 character string you choose. Click the ‘Help’ button 
for more information.  

For this example, we will give the report a description of ‘First Floor Temperatures’ and the filename ‘FLOOR1’ 
(you may use a different description and filename if you wish). 
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6.2 Editing a Report  

With the ‘Reports’ folder open, click on the report you wish to edit and then click the ‘View’ button. A screen 
similar to figure 6.2 will appear. This is our new report (it is empty until we add something to it).  

White area is the
‘editable’ portion of a
report. This is where
you can place boxes

pictures, text, etc.

The description of this report.  

Figure Chapter Six .2 Empty Report  

You will probably want to edit the report and add something to it so it will be more useful. Select ‘Edit Mode’ 
from the ‘Options’ menu. The report is now in ‘Edit Mode’ and the description at the top will change to ‘Editing: 
First Floor Temperatures’. Notice also that the ‘Options’ menu has changed to include some new selections.  

Now let’s add a ‘component’ to the report. Any box, line, picture or text string that you can add to a report is 
referred to as a ‘component’. CSS comes with several pre-defined components. In this example we will place 
the  temperature readings for the first floor on the report. To see the components and choose one to use for the 
first floor’s temperature, select ‘View Components’ from the ‘Options’ menu.  
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The components will be displayed in the ‘Components’ folder.   

S elec t th is ic on to p lac e text on
the report.  

Figure Chapter Six .3 Components Folder  

For this example, choose the ‘String Display’ component. Click the left mouse button on it (it should now be 
highlighted) and then click on the reports ‘editable’ area at the approximate location that you want to place this 
temperature reading.  

Select the control point that represents one of the first floor zone temperatures. For this example we will assume 
the point is called ‘TEMP1.1’. See chapter 3 for information on adding control points to CSS.  

This component is now a part of the report. You should see a blue square with eight red ‘handles’ around it and 
‘Value=‘ written inside. The handles indicate that this is the ‘selected’ component.   

As you move the mouse cursor over the components handles you will see the mouse cursor changing its shape. 
If you place the cursor over one of these handles and hold the left mouse button down you will be able to re-size 
the component as you move the mouse around the report. You can also press and hold the left mouse button 
anywhere else on the component and move the component itself around the report.  

Tip! You can hold down the <Ctrl> key and click to select multiple components. They can then be moved 
around, cut, deleted, etc. at the same time.  
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6.3 Editing Components  

To edit the appearance and behavior of a component, select it by clicking the left mouse button anywhere on 
the component. It will then have eight red sizing ‘handles’ around it. Click and hold the right mouse button over 
the component and a menu will appear. Select ‘Edit...’ or press <Ctrl>-E and you will see a dialog box similar to 
figure 6.4.  

Set the caption to
‘Temp1.1=@’ or any
other text you wish.
The @ is where the
value will appear. Use the scroll

bar to see more
options.

Click the ‘Help’
button for a
description of all
options.  

Figure Chapter Six .4 Component Editor  

Change the caption to read ‘Temp1.1=@ ’ or any text you wish this component to show. Place an ‘@’ where you 
want the actual value read from the controller to be inserted into the text. Feel free to change the color, 
alignment or any other options you wish to try. You can always click the ‘Cancel’ button to abort all of the 
changes you have made. For this example, set the ‘Field Name’ to ‘TEMP11’. You can normally use any field 
name you wish. Click ‘OK’ to save the changes to this component.  

After changing the caption of this component, it may not be large enough to display all the text. You can grab 
one of the components sizing handles and move the mouse around until it has the appearance you want.  

Once you are satisfied with a component’s appearance, you may want to click the right mouse button on it and 
select ‘Save as Component’. This will add it to the components folder, saving the size, color and behavior. You 
can then easily place it on other reports by selecting it from the components folder just like one of the pre-
defined components. You should probably not save every component you design because eventually you will 
have so many that it would be difficult to find the one you want.   

Repeat the above steps for as many zone temperatures as there are on the first floor. For this example we will 
assume two sensors, named ‘TEMP1.1’ and ‘TEMP1.2’, with the ‘Field Name’ set to ‘TEMP11’ and ‘TEMP12’.  

When you have placed all the zone sensor readings as desired, place another string component on the display 
and when prompted for a control point, press the close button without selecting a point. We will use this string 
as a calculated field, so we don’t need it to reference any control point.  

Change the caption of this new string to read ‘Floor 1 Average=@ ’ or any text you wish this component to 
show. To complete this example, set the ‘Calculation’ field to ‘(TEMP11+TEMP12) / 2’. This tells the component 
to add the values of the fields ‘TEMP11’ and ‘TEMP12’ together, then divide the result by 2 to obtain the 
average first floor temperature.        
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6.4 Calculations on Reports 

A calculation can be used to modify the value displayed for the control point. Use +,-,* and / in any order you 
wish but multiplication and division are always evaluated before addition and subtraction. Enclose sections of 
the calculation in parenthesis to force another order of evaluation.  

Example: 10+10 / 2 equals 15, but  
(10 + 10) / 2 equals 10  

Several built-in variables are available: 
$LONGDATE  Displays the current date (Saturday, February 08 1997) 
$SHORTDATE Displays the current date (2/08/97) 
$LONGTIME  Displays the current time (12:30pm) 
$SHORTTIME Displays the current time (12:30) 
$LONGDOW  Displays the current day of week (Saturday) 
$SHORTDOW Displays the current day of week (Sat) 
$LONGMONTH  Displays the current month (February) 
$SHORTMONTH Displays the current month (Feb)  

$LONGYEAR  Displays the current year (1997) 
$SHORTYEAR Displays the current year (97) 
$MONTH Displays the current month (01-12) 
$DAY Displays the current day (01-31) 
$HOUR Displays the current hour (00-23) 
$MINUTE Displays the current minute (00-59) 
$SECOND Displays the current second (00-59)  

These variable cannot be embedded in a calculation. They must be the ONLY text in the calculation field. 
Current date and time are read from the computer CSS is currently running on, not from the controller.  

6.5 Viewing a Report  

To view a report, select ‘Report’ from the ‘View’ menu and a ‘Reports’ folder similar to figure 6.5 will appear. 
Highlight the report you wish to view and click the ‘View’ button. You may also double click the left mouse button 
on the icon of the report you wish to view.  

There may be other pages that have more
reports on them. Click the ‘Tabs’ to see
them.

Double click this icon
to view the ‘First Floor
Temperatures’ report. 

Figure Chapter Six .5 Reports Folder  

Reports can be printed automatically using the Event Scheduler, pressing the 'Print' button while a report is 
being viewed, a user defined button on a graphic display, or through a script file by using the 'CSSPrintReport' 
command.  

6.6 Closing a Report  

When you are finished viewing a report it can be closed by selecting ‘Close’ from the ‘Window' menu. A report 
may also be closed  by double clicking the left mouse button on the Windows ‘Control Menu’ at the top left of 
the report. Reports should always be closed when you are finished viewing them.  
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Chapter Seven - Script Files  

7.1 Script File Overview  

Script files are small programs that you can write to automate certain tasks and extended the functionality of 
CSS. The script files implemented in CSS are Microsoft Visual Basic for Applications (VBA) V3.0 compatible. 
VBA is the same language that is used in many Microsoft products such as MS Access. A separate help file 
(SaxBasic.Hlp) is included that explains all of the VBA commands available for use.  

Several good books about VBA are available that will help you to learn how to write elaborate VBA scripts. You 
may even already have documentation for VBA in your MS Access or MS Excel manuals. Most of the scripts 
you will need to write in CSS are generally going to be very simple, but if you do decide you need a book about 
VBA make sure to look for a book on Visual Basic for Applications, not Visual Basic the program. There are a 
few example scripts in the \CSS\SCRIPT directory for you to use or modify as necessary.  

Script files may be executed in several different ways:  

Selected from the menu - Select "Execute Script" from the "Tools" menu. 
From a Graphic display - A button on a graphic display may be set to execute a script file.  
As a scheduled event -  Set a script to execute hourly, daily, monthly, etc.  
On reception of an alarm - An incoming alarm may trigger a script file to execute.   

All script files must be placed in the \CSS\SCRIPT directory.  

Edit the file ‘SHELL.BAS’ in the \CSS\SCRIPT directory for an empty program into which you can start adding 
commands.  

7.2 Script File Commands  

All CSS specific commands are prefixed with 'CSS. These commands may be freely mixed with the built-in VBA 
commands.  

CSSAutoModeOn <no parameters> 
Prohibits CSS from displaying dialog boxes that require user input. This command should be used when 
executing a script file while the computer will be unattended. Otherwise the script file may be paused for 
hours waiting for someone to press a key. Be aware that if CSS needs to ask the user a question (such as 
"Abort Changes?") because it was left in some type of editing mode, the answer will always default to NO.  

CSSAutoModeOff <no parameters> 
Enables CSS to display dialog boxes that require user input. See CSSAutoModeOn. This is the default 
mode.  

CSSBackup "Data to Backup", "Path and Filename" 
Save a controllers memory to disk. "Data to Backup" follows the same rules as specified in Event Editing. 
"Path and Filename" can be any valid Windows filename (e.g. "C:\CSS\BACKUP\BACKUP.PRG").  

Returns TRUE if the backup was completely successful. CSS must already be connected for this 
command to work properly.  

Example: 
If CSSBackup "1 2 3 4 5 V M C" , "C:\CSS\BACKUP.PRG" then Debug.Print "Backup Successful"  

CSSCaptionSet "Text for Caption" 
Sets the caption at the top of the main CSS window to the text specified. This is useful for informing the 
user what as to what action is taking place, or for debugging a script file. You may set the caption as often 
as you like.          
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CSSCollectHistory "Filename" 
Collects and stores the historical data for the history chart specified by "Filename".  This is the name 
supplied in the "Filename" entry of the history edit dialog box. Do not include the filenames extension.  

Returns TRUE if the history collection was completely successful. CSS must already be connected for this 
command to work properly.  

Example: 
If CSSCollectHistory "FANHIST" then Debug.Print "History Collection Successful"  

CSSComCaptureFile "Filename" ,  <Overwrite Flag> 
Opens a file that all further input from the controller will be copied into. "Filename" is any valid Windows 
path and filename. "Overwrite Flag" should be 1 to overwrite the existing file, or 0 (zero) to append to the 
end of the existing file.  

Example: 
'capture and print a report  
CSSComCaptureFile "\CSS\CHREPORT.TXT",1 'save in \CSS\CHREPORT.TXT, overwrite file if present 
CSSComTransmit "CHREPORT^M"                  'request the chiller report 
CSSComWaitString "R>" , 30                             'wait up to 30 secs for the R> prompt to be received 
CSSComCaptureOff                                              'R> received so must be end of report 
CSSPrinterSet "HP LaserJet on LPT1:"             'set printer to use 
CSSPrinterFontSize 10                                         'set printer font size to 10 
CSSPrintFile "\CSS\CHREPORT.TXT"        'print the entire file on the printer  

CSSComCaptureOff 
Turns the capturing of incoming data from the controller off.  

CSSComFindString "String to Find" 
<Advanced Users> 
Find a string on the "virtual terminal" screen. CSS maintains an copy of the last 200 lines sent to it by the 
controller. This is called the virtual terminal. The number returned by this command is the line number that 
the given string is most recently found on. The actual value of the line number is not especially meaningful 
by itself, it should be supplied to the CSSGetLine command to retrieve a particular line.  

Example: 
CSSComTransmit "Print CHWS^M" 'request value of CHWS input 
CSSComWaitString "R>" , 10  'wait up to 10 secs for the R> prompt to be received 
L=CSSFindString "CHWS"  'get most recently received line that contains "CHWS" 
A$=CSSGetLine(L)    'get that line    
Debug.Print A$    'A$ should now contain "CHWS   =  45.65"  

See Also: CSSGetPointValue, CSSGetLine  

CSSComGetLine <Numeric Value (0-200)> 
<Advanced Users> 
Returns the line from the "Virtual Terminal" screen (see ComFindString) specified by <numeric value>.   

CSSComTransmit "String to Transmit" 
Transmit a string of characters out the currently active communication port (i.e. to the controller if 
connected). Note that the special characters in the "Communications" section of  "System Setup" are 
supported ($ for 1/2 second pause and ^ for a control character).  

Example: 
CSSComTransmit "Print History All^M" '^M is a carriage return  

CSSComTransmitChar <Numeric Value (0-255)> 
Transmit a single character out the currently active communication port (i.e. to the controller if connected).   

Example: 
CSSComTransmitChar 27 '27 is the ASCII code for the Escape key         
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CSSComWaitString "String to Wait for" , "Seconds to Wait (0-28800)" 
Pauses execution of the script file until the "String to Wait for" has been received from the controller, or 
until "Seconds to Wait"  seconds as elapsed. Returns TRUE if the "string to Wait for" was received within 
the allotted time.  

Example: 
CSSCaptureFile "\CSS\CHREPORT.TXT",1 'save in \CSS\CHREPORT.TXT, overwrite file if present 
CSSComTransmit "CHREPORT^M"  'request the chiller report from controller 
If CSSComWaitString "R>" , 30 then Debug.Print "Report Received" 
CSSComCaptureOff    'Close capture file   

CSSComWaitStringTM "String to Wait for" , "Seconds to Wait (0-28800)", "COM Timeout (0-28800)" 
Pauses execution of the script file until the "String to Wait for" has been received from the controller, or 
until "Seconds to Wait"  seconds have elapsed, or until "COM Timeout" seconds have elapsed with no 
communications received from the controller. Returns TRUE if the "string to Wait for" was received within 
the allotted time.  

Example: 
CSSCaptureFile "\CSS\CHREPORT.TXT",1 'save in \CSS\CHREPORT.TXT, overwrite file if present 
CSSComTransmit "CHREPORT^M"  'request the chiller report from controller 
If CSSComWaitStringTM "R>" , 30,5 then Debug.Print "Report Received" 
CSSComCaptureOff    'Close capture file  

CSSConnect "Disk Directory Name" 
Connects with the controller specified by "Disk Directory Name". This is the name supplied in the "Disk 
Directory" entry of the controller edit dialog box. Do not include the .CTL extension.   

Example: 
CSSConnect "TESTINF" 
CSSConnect A$  

See Also: CSSDisconnect, CSSCtrlConnected, CSSCtrlName, CSSCtrlPath, CSSOfflineEdit  

CSSConvertHistory <History Filename, Text Filename, BeginDate, EndDate> 
Converts historical data from a CSS history chart to ASCII data for export into other Windows programs. 
"History Filename" is the filename specified for the history chart in the "Edit Histories" dilaog box. "Text 
Filename" is then file path and name in which  you want the ASCII data to be stored. "BeginDate" and 
"EndDate" are VBA "Date" variables containing the range of the data you wish to convert. All data from the 
"Begin Date" up to but not including the "End Date" will be converted. This command returns TRUE is the 
data was successfully converted, otherwise it returns FALSE.  

Note: CSS must be connected with a controller (or in Offline Edit mode) before using this command.  

Example: 
'Convert the last 7 days of historical data from the chart "HstChrt1" and  
'store it in the file "C:\CSS\MYDATA.TXT"  

CSSOfflineEdit "INF1"  'select the controller "INF1" for OFFLINE EDIT mode 
CSSConvertHistory("HstChrt1","C:\CSS\MYDATA.TXT", Now-7,Now)  
CSSDisconnect  

'"Now" returns the current time and date, "Now-7" returns the the current time, seven days ago 
'You can also use the "DateSerial" VBA command to use specific dates: 
'CSSConvertHistory("HstChrt1","C:\CSS\HistTest.Txt",DateSerial(1996,7,29),DateSerial(1996,9,7))  

The format of the converted data file is: 
Line 1: Description of the chart 
Line 2: Units Description 
Line 3-10: Point names of the data  

The remainder of the file is the converted data in the format: 
mm/dd/yyyy hh:mm <value1> <value2> <value3> <value4> <value5> <value6> <value7> <value8>    

Data is always stored in the text file with the most recent reading at the end of the file.      

CSSCtrlConnected <no parameters> 
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Returns TRUE is CSS is currently connected to a controller. Can be used to determine if the previous 
CSSConnect command was successful.  

Example: 
If CSSCtrlConnected then CSSDisconnect  

CSSCtrlName <no parameters> 
Returns the name (description) of the controller CSS is currently connected to, or "" (empty string) if not 
connected.  

Example: 
Debug.Print "Currently Connected to: " & CSSCtrlName    

CSSCtrlPath <no parameters> 
Returns the path of the controller CSS is currently connected to, or "" (empty string) if not connected. The 
returned path will already contain an ending backslash (\).  

Example: 
Debug.Print "Path to Controller is: " & CSSCtrPath 
CSSBackup "ALL" , CSSCtrlPath & "BACKUP\BACKUP.PRG"  

CSSDisconnect  
Disconnects from the current controller.   

Example: 
CSSDisconnect  

See Also: CSSConnect, CSSCtrlConnected, CSSCtrlName, CSSCtrlPath, CSSOfflineEdit  

CSSFormsCascade <no parameters> 
Cascades (arranges and overlaps) all displays, schedules and history charts currently open within CSS.  

CSSFormsClose <no parameters> 
Closes all displays, schedules and history charts currently open within CSS.  

CSSFormsTileHorz <no parameters> 
Horizontally tiles (arranges to fit on screen) all displays, schedules and history charts currently open within 
CSS.  

CSSFormsTileVert <no parameters> 
Vertically tiles (arranges to fit on screen) all displays, schedules and historiy charts currently open within 
CSS.  

CSSGetPointValue "Point Name" 
Retrieves the value of the given controller input, output or variable. The value is returned as a string.  

Example:  

A$=CSSGetPointValue "ZONETEMP1" 'get the value of input "ZONETEMP1" 
V=CSng(A$)    'convert A$ to a single precision number 
if (V < 65.0) OR (V>85.0) then Debug.Print("ZONETEMP1 is Out of Range.")  

CSSOfflineEdit "Disk Directory Name" 
Connects with the controller specified by "Disk Directory Name" in OFFLINE EDIT mode. This is the name 
supplied in the "Disk Directory" entry of the controller edit dialog box. Do not include the .CTL extension.   

Example: 
CSSOfflineEdit "INF1"  

See Also: CSSCtrlConnected, CSSCtrlName, CSSCtrlPath  

CSSPrintFile "Filename" 
Prints the entire file specified by "Filename" to the currently selected printer.  

Example: 
CSSPrintFile "C:\CSS\REPORT.TXT"  

CSSPrinterFontSize <Numeric Value> 
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Sets the font size for the currently selected printer. Note: it is not possible to set the font type with this 
version of CSS. It may be possible with a future version. Try changing the printers default font in the 
Windows printer setup.  

Example: 
CSSPrinterFontSize 10  

CSSPrinterSet "Printer Name" 
Sets the specified printer to be the currently selected printer. "Printer Name" should be typed exactly as it 
appears in the list of printer maintained by Windows.  

Example: 
CSSPrinterSet "HP LaserJet Series II on LPT1:"   

CSSPrintReport "Filename" 
Prints the report specified by "Filename". "Filename" is the name contained in the "Filename" entry of the 
"Report Edit" dialog box.  

CSSUserLevel <no parameters> 
Returns the CSS password level of the current user or -1 if no user is logged in to CSS.  

Example: 
If CSSUserLevel=1 then Debug.Print "Function not available at your password level."  

CSSViewDisplay "Filename" 
Opens the graphic display specified by "Filename". "Filename" is the name contained in the "Filename" 
entry of the "Display Edit" dialog box.  

CSSViewHistory "Filename" 
Opens the history chart specified by "Filename". "Filename" is the name contained in the "Filename" entry 
of the "History Edit" dialog box.  

CSSViewReport "Filename" 
Opens the report specified by "Filename". "Filename" is the name contained in the "Filename" entry of the 
"Report Edit" dialog box.  

See Also: CSSPrintReport  

CSSViewSchedule "Filename" 
Opens the schedule specified by "Filename". "Filename" is the name contained in the "Filename" entry of 
the "Schedule Edit" dialog box.   
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Chapter Eight - Tutorial: Other Features   

8.1 System Setup: General 

General Setup contains options that affect the appearance and operation of CSS. You can access these option 
through the FILE|SETUP|SYSTEM menu.  

 

Figure 8.1 System Setup - General  

Logon as User - Specify a user name to automatically log in as that user each time CSS is executed. The 
opening password screen will be bypassed.  

Connect To - Specify a controller to automatically logon to each time CSS is executed. A startup user 
must also be specified.  

View Display - Specify a display to automatically load each time CSS is executed. A startup user and 
controller must also be specified.  

Alarms: Enabled - Check this box if you want alarms to be enabled. You will normally want to leave this 
checked.  

Alarms: Continuous Beep - Check this box if you want CSS to beep (or play a standard Windows sound 
effect) every second after an alarm is received. The sound will continue until you view the alarm 
report. Leave it unchecked to have CSS beep only once for each alarm received.  

Alarms: Alarm Printer - The printer on which you want to print alarms.  

Default Folder View - Select the appearance you want folders to have as a default. You can always 
change the folder’s appearance while viewing it by clicking the right mouse button and selecting ‘List 
View’.  

Activity Log Enabled - Check this box if you want all user activity to be logged in monthly log files. Every 
important action taken by a user will be recorded in this file. The log files are stored in the \CSS\LOG 
directory.  

Auto Maximize Forms - Check this box if you want forms (displays, schedules and history charts) to 
automatically be maximized, that is, to fill the entire screen.  

Change Font - Allows you to change the font used throughout CSS. This is supplied mainly for low 
resolution video modes or certain video cards that may have nonstandard resolutions. If you notice 
text in any forms being chopped off, changing the font may solve the problem.   
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8.2 System Setup: Communications  

Click this tab to access the
Communications options.

See section on modem setup
for proper modem initialization
strings.

Every new controller will
initially have these settings.
Ports also use these settings
when not connected to a
controller. 

Figure 8.2 System Setup - Communications  

Default Main Port - The default COM port and baud rate that will be used to communicate with controllers. 
Each controller can be configured separately. This is the default setting it will have when it is created.  

Default Alarm Port - The default COM port and baud rate used to receive alarms. This may be set the 
same as the main port, or be a secondary port attached to a modem for reception of alarms from 
remote sites. Each controller can be configured separately. This is the default setting it will have when 
it is created. Alarms will be received from the main port as well as the alarm port.  

Ctrl Char. Prefix (Control Character Prefix) - A symbol used in connect strings, disconnect strings, etc. 
that will force the following letter to be transmitted as a control character. I.E. ^M will transmit a 
Control-M or carriage return (ASCII 13).  This should not normally be changed.  

1/2 Sec. Pause - A symbol used in connect strings, disconnect strings, etc. that will cause a 1/2 second 
delay in transmission. This should not normally be changed.  

Phone Service - Select the type of phone service active in your building.  

Modem Inits - The strings used to initialize the modem before dialing. Each controller can have its own 
modem initialization string. This is just a convenient place to enter the most common ones you may 
need.  
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8.3 System Setup: Tools  

‘Tools’ are a list of executable programs that are accessible through the ‘Tools’ menu. A few of these tools must 
be included in the list (Terminal mode, Text Editor, Paint Program), but the actual program executed by them 
may be changed. For example, Text Editor defaults to ‘NOTEPAD.EXE’ but may be changed to 
‘WINWORD.EXE’ although you cannot remove text editor from the list of tools.  

Click this tab to access the
Tools options.

Up to fifteen tools may be
added to the ‘Tools’ menu. 

Figure 8.3 System Setup - Tools  

Insert Button - Allows you to insert or add a new tool.   

Delete Button - Deletes the currently selected tool.  

Browse Button - Displays a dialog box that allows you to select which program you want this tool to 
execute. Any .EXE, .COM, or .BAT file may be selected. Script files may be included by selecting the 
.BAS file from the \SCRIPT directory. 
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8.4 Alarm Viewing  

Alarms are messages sent from controllers (and occasionally generated by CSS itself) that warn you of 
situations that need attention. Select ‘Alarms’ from the ‘View’ to display a form similar to figure 8.4.  

The highlighted alarm will be
fully displayed in this area.

Alarms are stored by
month. Click here to
view a different
month.

Up to 100 alarms can be
displayed in upper window.
Click arrows to see
next/previous set of 100. 

Figure 8.4 Alarm Viewer  

Viewing Alarms - The upper section of the alarm report contains up to 100 of the most recent alarms. 
Click on the scroll bar to the right of the alarms to move through the current set of alarms. If there are 
more than 100 alarms for the selected month, you may click one of the arrow buttons at the bottom 
left of the alarm report to see the next/previous set of 100 alarms. The view mode may be changed 
between ‘All’ alarms, ‘Active Only’ (unacknowledged) alarms and ‘Search’ which allows displaying 
only those alarms that contain certain words or phrases. To view alarms from a previous month, 
select the month from the list just above the ‘Active Only’ check box. The full text of an alarm will be 
displayed in the lower portion of the alarm report when it  is selected (see below).  

Selecting Alarms - To select an alarm, click the left mouse button on it in the upper portion of the screen. 
You may click and drag the mouse while holding down the left mouse button to select any number of 
contiguous alarms.   

Acknowledging Alarms - Clicking the ‘Ack.’ button will allow you to attach a comment to the selected 
alarms. You may wish the comment to explain why the alarms happened and/or how the problem was 
corrected. Once an alarm is acknowledged, it is no longer considered active. A comment is not 
required to acknowledge the alarm. The alarm is then stamped with the current date and time. The 
user that acknowledges it is also recorded.  

Deleting Alarms - Clicking the ‘Delete’ button will permanently remove the selected alarms from the alarm 
report. You will be asked if you are sure you want to delete them before they are actually deleted. It is 
not possible to restore an alarm once it has been deleted.  

Printing Alarms - Click the ‘Print’ button to print the alarms to the printer. You will have the option of 
printing all alarms on record for the currently selected month, or printing only the currently selected 
alarms. 
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8.5 User Editing 

A ‘User’ is someone you want to have access to CSS. Up to 1024 users may be entered into the system. Select 
‘FILE|SETUP|USERS’ to display a form similar to figure 8.5. You must have level 3 access to edit users.  

 

Figure 8.5 Edit User Form  

Name - The name this user will type at the opening screen to gain access to CSS.  

CSS Password - The password this user will type at the opening screen to gain access to CSS.  

Controller Password - The password that will be used to log on to controllers when this person is using 
CSS. Leave blank if you want CSS to use the controllers default password.  

Access Level - The level of access you want this user to have. Only level 3 users will be able to edit 
users. Make sure you always have at least one user with level 3 access!  

Custom User Access - Each user can be granted or denied access to most functions of CSS. Check each 
action you want this user to be able to perform.    

8.6 Backup Controller’s Memory  

Select ‘CONTROLLER|BACKUP MEMORY’ to save all of the controller’s programs and other data to disk. The 
backup process is fully automated once you have supplied the following information:  

AC256 - Enter the ‘domain’ you want to backup and click the ‘OK’ button. Domain 0 (zero) is the main controller.  
Only one domain may be entered at one time. Next enter the ‘drums’ you want to backup. You will usually just 
click the ‘OK’ button to backup ‘ALL’, but individual drums (E.G. ‘1 2 3 C M’) may also be specified. Any number 
of drums may be backed up at one time.  

Infinity - Enter any valid data that you want backed up. You will usually just click the ‘OK’ button to backup 
‘ALL’, but individual objects and programs may also be backed up.  

CSS will suggest a filename based on the type of data you are backing up and the current date. You are free to 
change the filename or just click the ‘OK’ button to use the default filename.   
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8.7 Restore Controller’s Memory  

Select ‘CONTROLLER|RESTORE MEMORY’ to reload all of the controller’s programs and other data from disk. 
The restore process is fully automated once you have selected the file that you want to restore. CSS does not 
do any special preparation of the controller before restoring its memory (like setting of options or controller com 
ports). You must make sure that you do this before selecting ‘Restore Memory’.  

8.8 Event Scheduling  

Events cause CSS to perform certain actions at regular intervals without the need for user intervention. CSS 
can manage up to 100 events and can occur as frequently as every hour. Select ‘FILE|SETUP|EVENTS’ to 
display a form similar to figure 8.6.  

 

Figure 8.6 Schedule Events Form  

Description - Describes the event. This can be any text you wish.   

Event Type - Indicates what action will take place, history collection, memory backup, report printing or 
script file execution. Other event types may be added in future version of CSS.  

Enb (Enabled) - ‘Yes’ if the event is enabled to execute.  

Last Run - The date of the last execution of the event.  

Add Button - Allows you to add a new event.   

Edit button - Edit the currently selected event.  

Delete Button - Deletes the currently selected event.  
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8.9 Event Editing  

The event editor form allows a variety of scheduling options. Most commonly, you will want to perform controller 
memory backups at least once per month and history collections once per day.  

Multiple history collections or
report printouts may be
performed with one event. Click
the ‘Select’ button and choose
a different icon and it will be
added to the list. 

Figure 8.7 Event Editor Form  

Description - Describes the event. This can be any text you wish.   

Event Type - Indicates what action will take place, history collection, memory backup, report printing or 
script file execution. Other event types may be added in future version of CSS.  

Enabled - Check this box to enabled the event. NOTE: If the Start Date has already passed and you 
enable the event, it will be execute at the top of the next minute (when the minute changes).  

Controller - The controller you wish to connect with before executing this event.  

Parameter (backup event only) - Enter any parameters to the backup command here, such as ‘All’ or 
‘Site’. For AC256 controllers, a domain may be specified using a colon 1:ALL for domain #1 or 23:ALL 
for domain #23. The filename used for the backup will be AUTOxxxx, where xxxx is the current month 
and day. The file will be placed in the individual controllers \BACKUP directory.  

History File (history collection event only) - Indicates the history charts for which data should be 
collected.  

Start Time - The date and time you wish to start executing this event.  

End Time - The date and time to stop executing this event.  

Endless - Check this box to execute this event at the specified interval until you disable it.  

Frequency - Sets how often you want this event to execute. If you have a start date of 01/13/96 and set 
the frequency to 1 month, the event will execute on the 13th of every month. If the days are set to 
more days than there are in a given month, the event will occur on the 1st day of the following month. 
Setting the frequency to zero will cause the event to be executed one time only and then disabled. 
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8.10 Variable Watch  

Variable watch allows you to view a list of control points and their current values. The current values update at 
regular intervals. Variable Watch is useful for debugging and fine tuning controller programming.   

Click the ‘Timing’ button
to change how often the
values are scrolled to the
right. This example is
scrolling every ten
seconds.

Any list of control points may be
saved to disk for quick access
at a later time.

 

Figure 8.8 Variable Watch form  

Add Button - Add a new control point to the list.  

Edit Button - Change a control point on the list.  

Delete Button - Delete the control point from the list.  

Save Button - Save the current list of control points to a disk file for quick access at a later time.  

Load Button - Load a previously saved list of control points.  

Cmd Button (Controller Command) - Issue a command to the controller. Useful for disabling or modifying 
points, running controller programs, etc..  

Timing Button - Change the interval at which the control points update and the current values are 
scrolled.  
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Chapter Nine - Technical Information  

9.1 Alarm Setup in Controller  

NOTE: Alarms will NOT be received when you are using terminal mode.  

Alarms must be generated by the controller. Usually this is done in the controllers programming.  (See Infinity 
Alarm Programming or AC256 Alarm Programming) When the controller detects an alarm condition, it should 
display a message that contains the following codes:   

{A#TEXT<SCRIPT>^ID^[>DATE }  

Where:  

{       = start of message marker 
A or a = Lowercase 'a' will not cause the alarm box on the status line to flash or increment the number of 

alarms. Use this if you only wish to print something to the printer, but don't want to make anyone think 
there is an alarm. 'M' and 'm' are still supported for compatibility with Monitor but are treated as 'A' or 
'a'. 

#    = destination of message 
   0 = none  

1 = printer  
2 = disk file (add to alarm report)  
3 = printer and disk file   
4 = printer (included for compatibility with Monitor, use 1 instead)  
5 = printer (included for compatibility with Monitor, use 1 instead)  
6 = printer and disk file (included for compatibility with Monitor, use 3 instead)  
7 = printer and disk file (included for compatibility with Monitor, use 3 instead)    

TEXT     = the actual text of the message 
<SCRIPT> = the name of a script file to run (optional). Up to eight characters. Do not include the .BAS 

extension.  
^ID^   = an up to eight character "alarm ID" of the controller that generated the alarm (optional) 
[>DATE   = the date and time of the message (optional). Ignored, included for compatibility with Monitor.  
}    = end of message marker   

This example will send an alarm to the printer:  
{A1Zone 1 Temperature is Out of Range (78.5 Deg.f)}  

This example will print the alarm on the printer and store it in the alarm file of the controller that has the Alarm 
ID of “CTL1":  

{A3Airhandler #1 has Exceeded 300 Hours of Runtime^CTL1^}  

The maximum length of an entire alarm message is 170 characters. The actual text of the message may be no 
longer than 120 characters. CSS will split the text of the message into two lines of 60 characters each.   

9.2 Infinity Alarm Programming  

NOTE: A program must be loaded into the controller for Alarms to operate as described in this section. 
Connect to the controller and select 'Load Controller Programs' from the 'Controller|More' menu. You 
will only need to do this once for each controller.  

Programming alarms for the Infinity controller presents a few problems:  

If the controller simply prints the message to the screen, CSS will see the alarm up to 8 more times as the alarm 
message scrolls off the top of the screen.  

If the alarm message is displayed on the status bar, CSS will see the alarm every time the screen redraw 
(<Ctrl>-Z>) command is used (as is done occasionally by CSS itself).  

If a com port is opened in "raw" mode and the messages are printed, it can cause problems with any displays 
that are being viewed, history collections, etc. 
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The simplest (but not ideal) solution is to create a string variable in the controller named "CSSAlarmMsg" (any 
name will work) and place a program similar to the following in the controller:  

Line Checking  
If Length(CSSAlarmMsg) > 0 then   
    Print "{";CSSAlarmMsg;"}" to Comm3 StatusBar  
    CSSAlarmMsg=""  
    Goto Clearing  
Endif  

Line Clearing  
Print "" to Comm3 StatusBar   
Goto Checking   

Any program may then set CSSAlarmMsg = "A2Zone Temperature is Out of Range"  and the alarm will be 
displayed on the status bar and erased on the next controller scan automatically. If this program is set at the 
end of the firing order, CSSAlarmMessage will only contain a string for a maximum of one scan.  

using this method, any program that prints on the status bar would have to check to make sure an alarm wasn't 
active before printing:  

If Length(CSSAlarmMsg) = 0 then Print "YourInformation" to Comm3 StatusBar  

If you aren't concerned about getting an occasional duplicate alarm message, you could simply:  

Print "|123A2Zone Temperature is Out of Range|125" to Comm3 StatusBar  

(the |123 and |125 are equivalent to the '{' and '}' characters. See Alarm Setup in Controller)  

9.3 AC256 Alarm Programming  

Alarm programming in the AC256 is very straightforward. Simply store an alarm in a message line and display it 
from within a drum program at the appropriate time:  

Drum M  
M200 = {A2Zone Temperature is Out of Range, Zone1 = "Zone1}  

Drum 301  
Display 200  

9.4 Designing Displays           

At any time while viewing a display, you may select "Edit Mode" from the "Options" menu. This will allow you to 
edit the display in any way you wish.  The display will continue to update normally while in edit mode. This 
allows you to see exactly what affect your changes will have. Keep in mind that you may have several displays 
open at one time but switching to edit mode affects only the currently active display. You may activate edit mode 
on multiple displays and copy components between them.  

Once the display is in edit mode, the options menu will change to contain the following:  

View Mode - Quit edit mode.  
Save - Write your changes to disk. 
Configure - Allows you to specify the background picture, size the display, etc. 
Edit Picture - Execute the drawing program specified in System Setup. 
View Components - View the "Components" folder. This allows you to add components to the display.  

If this is a new display it will initially be empty. The first thing you may want to do is select "Configure" from the 
"Options" menu and specify a .BMP file to use as a background picture (all user supplied bitmaps must be 
placed in the \CSS\BITMAP directory) or the background color if no background picture will be used.  

Placing Components 
Before placing components on the display you must first select "View Components" from the "Options" menu. A 
"floating" folder will appear that contains all of the available components. You may move this folder anywhere on 
the screen and it will stay on the screen until you close it or until you quit edit mode.   
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To place a component on the display, select it in the component folder and click anywhere on the display. The 
component will then appear on the display. If the component requires a control point the "Control Points" folder 
will appear. Select which point you wish this component to reference.  

NOTE: The only limit on the number of components that may be place on an individual display is the 
size of the .DIS file. It has a limit of about 65,000 bytes. This equates to roughly 200 string components 
(the smallest component) or about 100 circular meters (the largest). You should not normally have to 
worry about this limitation. If it does become a problem, split the data you are trying to present between 
multiple displays and use a button component to switch between them.  

Moving and Sizing Components 
Once the component has been placed it becomes the "selected" component. You can easily see which 
component is selected because it will have 8 red "handles" around its edges. If you left click on one of these 
handles and drag the mouse while holding the left mouse button down the component will grow larger or smaller 
depending on the direction you move the mouse. If you left click anywhere else on the component and drag the 
mouse, the entire component will move. You can at any time select another component by clicking on it with the 
left mouse button. You can also select multiple components by holding down the <Ctrl> key and left clicking on 
another component. Some functions will not be available while multiple controls are selected.  

Editing Components 
Once a component is selected, clicking the right mouse button will bring up the following menu:  

Control Point - Change the control point referenced by this component. 
Edit - Edit the appearance and behavior of the selected component 
Save as Component - Save this component to the components folder.  
Align to Grid - Align this component to the screen grid. 
Bring to Front - Move this component in front of all other components. 
Send to Back - Move this component behind all other components. 
Align - Align the selected components on the screen or to each other. 
Size - Change the size of the selected components relative to each other. 
Delete - Delete the selected components from the display. 
Cut - Delete the selected components from the display and copy them to the clipboard. 
Copy - Copy the selected components to the clipboard. 
Paste - Paste the components currently in the clipboard onto the display. 
Select All - Select all the components on the display. 
Grid: Snap to Grid - Enable or disable grid alignment. 
Grid: Grid Spacing - Specify spacing of the grid.  

Once the component has the appearance and behavior that you desire, you may want to select the "Save as 
Component" option. This will allow you to place this modified component on any other display without having to 
edit it again.  

9.5 Display Diagnostics  

Debug Mode 
Debug mode displays a terminal window over the top of any displays, schedules or history windows that are 
currently open. All communication between CSS and the controller  is displayed in this terminal. You can click 
the mouse in the terminal and type commands to the controller, but be careful because CSS will continue to 
communicate even while you type. To activate Debug Mode, select 'About' from the 'Help' menu. If your 
password level allows terminal mode access, there will be a 'Debug Mode' check box. Check the box and close 
the 'About' window.  

Display Diagnostics 
<Infinity Only>  

When updating graphic displays, CSS will ask the controller for as many points per scan as the controller will 
accept. Unfortunately, if any one of the points CSS asks for is not valid, the Infinity will not return ANY of the 
values. This means if there is one component on a display that has a nonexistent point assigned to it, it can 
cause several of the components to not update correctly, or not update at all.  

If CSS recognizes this happening, it will display an error message alerting you to the problem. However, CSS 
cannot detect which point is invalid. The easiest way for you to find the offending point is to put the display in 
'Edit' mode, then select 'Diagnostic' from the Options menu. This will force CSS to temporarily ask the controller 
for the point values individually. Then activate 'Debug Mode' (see above). Now you can watch the 
communications between CSS and the controller while it is happening. You should be able to see which points 
the controller is rejecting and correct the problem.   
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9.6 Modem Setup  

The only required setting for a modem used with CSS is AT&C1 (Carrier Detect only when connected). 
however, it is suggested that the modem also be given the setting AT&D2 (hang up modem on DTR drop) to 
assist in hanging up.  

So the minimum recommended modem initialization is AT&C1&D2.  

Some high speed modems (9600 Baud and higher) may require ATN0 (ATN 'zero') also. This will force the 
modem to always connect at the speed that CSS is set to. If this parameter is not used and you call a controller 
that has a 9600 baud modem attached but is set to communicate at 2400 baud, the modems will still connect at 
9600, making communication with the controller impossible.  

The modem initialization would now be AT&C1&D2N0.  

The optimum settings for most high speed modems would be AT&F&C1&D2N0.  

It has been reported that some modems may hang-up when switching to terminal mode (caused by DTR 
dropping for a few milliseconds). If this is happening, you may need to use AT&D0 instead of AT&D2. Some 
modems are apparently more sensitive to DTR dropping than others. You may also check to see if your modem 
has an ‘S’ register that specifies how long DTR must be dropped to hang up and raise that value.  

9.7 Directories and Filenames  

Directory Structure 
The following directory structure is used in CSS: 
(it is assumed the program was installed in the default \CSS directory)  

\CSS - Main directory. Contains CSS.EXE, help files, etc. 
\ALARM - Alarms received when not connected to a controller. 
\BITMAP - Bitmaps (pictures) used in all user designed displays. 
\CMP - Display components. 
\ICON - All icons used in folders. You may add new icons or modify these as you wish. However, CSS 

does expect some of them to be present so it is best not to delete any of them. 
\LOG - Monthly activity log files. Log files may be viewed with any text editor. 
\SCRIPT - All supplied and user written script files.    

For each controller added to the "Controllers" folder, a directory with a ".CTL" extension will be created within 
the \CSS directory. For example, if you added a controller and specified the directory as "TEST" in the controller 
edit dialog box, the following directories would be created:  

\CSS\TEST.CTL - Main directory for a controller. 
\CSS\TEST.CTL\ALARM - Alarms received when connected to this controller. 
\CSS\TEST.CTL\BACKUP - Files containing the controllers memory backups. 
\CSS\TEST.CTL\DISPLAY - User designed displays for this controller. 
\CSS\TEST.CTL\HISTORY - History data files. 
\CSS\TEST.CTL\REPORTS - Custom report files. 
\CSS\TEST.CTL\SCHEDULE - Schedule data files.  

Each controller will have its own directory. When a controller is deleted from the "Controllers" folder, its directory 
is actually just renamed to "\CSS\TEST.DEL". This will prevent CSS from seeing it as a controller. If you wish to 
reinstall the controller into the "Controllers" folder, rename the directory back to "\CSS\TEST.CTL" using file 
manager. If you are sure you want to totally delete this controller from your hard disk, the directory must be 
deleted manually using file manager.  

Moving Controllers 
A separate directory for each controller also simplifies moving a controller to a different computer. To move an 
entire controller to a different computer, simply backup the entire "\CSS\TEST.CTL" directory (along with all of it 
sub-directories) and restore it to the other computers "\CSS" directory. The only other files you may need to 
copy would be any .BMP files used by this controller that are in the "\CSS\BITMAP" directory.  

Filename Extensions 
All files used in CSS have a default extension. You should never supply an extension when asked to type a 
filename. All filenames should be 1-8 characters (0-9 or A-Z). Windows 95 long filenames are not supported.    
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The following is a list of many of the extensions used in CSS and their purpose. Most of these are simple text 
files that may be loaded into a text editor and modified manually. This makes certain things easier to do, such 
as changing the font of all of the components on a display. Entering invalid information into one of these 
files manually can cause unpredictable results! Make certain you have a backup of a file before you modify 
it.  

.ALM - Alarms received from controllers. Not user editable. 

.CMP - Display components. 

.CPR - Custom report components 

.DIS - User designed displays. 

.HST - History configuration file. 

.HSF - History graph settings file. Contains the settings of a history graph (2D/3D, colors, chart type, etc.). 
Not user editable. 

.INI - Text file that holds information about certain items, such as controllers "CTL.INI" or users 
"USERS.INI". 

.SCH - Schedule configuration and time/date values.  

.PRG - Controller memory backup file. 

.WAT - Variable watch configuration files. 
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9.8 Technical Support   

If you are having problems getting CSS to communicate with a controller make sure that:  

The desired communication ports (Comports) exist and are set up properly in Windows Control Panel. 

You have specified the proper comport and baud rate in the Controllers folder. 

The cable from the computer to the modem/controller is wired correctly. 

If you are sure this is all correct, read the section on Debug Mode.  

If you are still unable to communicate or are having other problems, contact your Andover dealer or:  

Custom Software Engineering 
1463 Countryside Drive 
Indianapolis, IN  46231 
(317) 247-4819 Voice (technical support hours are 9am to 1pm EST) 
(317) 247-1009 FAX/BBS   


